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CHAPTER 17 IMPORTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can import data from other sources or files into your Word 
documents. Microsoft makes it easy to import content created in 
other Microsoft programs into Word and vice versa. So, rather than 
recreating the content, you can make use of several paste special 
functions to import the content. 

In this session you will: 

 gain an understanding of importing data into Word 

 learn how to import text 

 learn how to import Excel data into a Word document 

 learn how to import linked Excel data 

 learn how to import and embed Excel data 

 learn how to modify embedded data. 

INFOCUS 
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UNDERSTANDING IMPORTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you import data into a Word document, 
you are inserting text or content from another file. 
Microsoft enables easy integration between 
Microsoft programs, which means that importing 

data from one Microsoft program to another is a 
simple process. Word provides several Paste 
Special options for importing data, which we will 
discuss here. 

How Importing Works 

You’re no doubt familiar with Word’s Cut, Copy and Paste tools that enable you to easily copy or 
move text within and between documents. Word also provides several Paste Special options when 
a straight copy and paste job will just not do.  

About Paste Special 

Using Paste Special, you can import data from any other compatible file or source into a Word 
document. You can import the entire contents of a file, for example, or you can import sections from 
another file. Once you have determined what data needs to be imported, you then have several 
Paste Special options available for how you want the data to be imported. For example, the picture 
below shows the Paste Special dialog box displaying a number of options for how to import part of 
an Excel worksheet. 

 

The default format is HTML Format, which will import the data as is, with all formatting preserved 
where possible. You can also import the data as formatted or unformatted RTF (Rich Text File) 
text. You can even import the data as a picture. You can also select whether the data will be 
linked to the source file or embedded into the document. 

Linking Imported Data 

When you import linked data, any changes made to the original (source) file or data will be 
updated automatically in the linked data in the Word document (if both documents are open or the 
next time the document containing the linked data is opened). That is because you have only 
imported a link to the source file, not the actual data itself. You must click on Paste link in the 
Paste Special dialog box to link imported data to the source file. 

Embedding Imported Data 

When you embed imported data, the data remains static, that is, changes made to the source file 
or data will not be reflected in the embedded data. Once imported, embedded data is no longer 
part of the source file. This means that the information in the Word document will not alter when 
you change the source file. 
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IMPORTING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Before starting this exercise you 
MUST open the files W883 
Importing_1.docx and W883 
Importing_2.docx... 

 Select the two main paragraphs 
in W883 Importing_2.docx as 
shown, then press  +  to 

copy the text to the clipboard 

Notice that the font is currently 
Constantia 11 pt... 

 Switch to W883 
Importing_1.docx, then click to 
the right of Julianne and press 

 

 Click on the Home tab, then 
click on the bottom half of Paste 

  in the Clipboard group and 

select Paste Special to open 
the Paste Special dialog box 

 Ensure that HTML Format is 
selected, then click on Paste 
link, then click on [OK] to paste 
the text with a link to the source 
document  

Notice that the font of the 
imported text has changed to 
match the document text… 

 Press  if required to delete 

the blank line between 
paragraphs, then save and 
close W883 Importing_2.docx 

 

For Your Reference… 

To import text: 

1. Select the source text, then press  +  

2. Open the destination document, then click on 

the bottom half of Paste  and select 

Paste Special 

3. Click on Paste link, then click on [OK]  

Handy to Know… 

 When pasting formatted text that does not 
need to be linked, click on the bottom of half 

of Paste  to display Paste Options. 

Options include Keep Source Formatting 
(to preserve original formatting) and Merge 
Formatting (to update the pasted text with 
the formatting in the destination document). 

1 

3 

As a general rule when you have to copy or move 
text between documents or files, you would most 
likely use Copy and Paste or Cut and Paste to 
do this. However if you want to preserve the 

formatting and create a link to the source data so 
that any changes will be updated in the destination 
document, you need to use the relevant options in 
the Paste Special dialog box. 

5 



Microsoft Word 2010 - Level 3 

© Watsonia Publishing Page 168 Importing 

IMPORTING EXCEL DATA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the previous file 

with this exercise, or open the 
file W883 Importing_3.docx... 

 Click on the Start button and 
select All Programs > 
Microsoft Office > Microsoft 
Office Excel 2010 to open 
Excel 

 In Excel, click on the File tab, 
then click on Open to open the 
Open dialog box, navigate to the 
course files folder and open 
W883 Importing_4.xlsx 

 Click on cell A2, press and hold 
 then click on cell G16, then 

press  +  to copy the data 

to the clipboard 

 Switch to Word, then click at the 
end of the fourth paragraph 
(after international office.) 

 Press  +  to paste the data 

into the document  

The data will be converted to a 
Word table, which you can edit 
like any other table. You will 
delete the table ready for the 
next exercise… 

 Click in the table, then click on 
the Design tab and click on 

Delete  in the Rows & 

Columns group, select Delete 
Table to delete the table, then 
save the document 

 

For Your Reference… 

To import Excel data: 

1. Open Excel and select the data 

2. Press  +  

3. Switch to Word and position the insertion 
point 

4. Press  +  

Handy to Know… 

 The Paste Options tag  that appears 

when you paste the table can be used to 
control the formatting. For example, you can 
Keep Source Formatting and Link to 
Excel which retains the Excel formatting and 
creates a link to the Excel source file. 

3 

5 

When you use the Copy & Paste and Cut & 
Paste functions in Word, data is selected and 
then moved or copied to another part of the 
document. The same principles apply when 

copying (or cutting) and pasting data from other 
files into a Word document. When you copy (or cut) 
and paste from an external file into Word, the 
formatting will be preserved. 
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IMPORTING AND LINKING EXCEL DATA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the previous file with 

this exercise, or open the file W883 
Importing_5.docx... 

 Ensure that W883 Importing_4.xlsx 
is open in Excel 

 Click on cell A2, hold down  and 

click on cell G16, then press  + 

 to copy the data to the clipboard 

 Switch to Word, then click at the end 
of the fourth paragraph (after 
international office.) 

 Click on the bottom half of Paste  

in the Clipboard group and select 
Paste Special to open the Paste 
Special dialog box 

 Click on Paste link, then click on 
Microsoft Office Excel Worksheet 
Object under As 

 Click on [OK] to insert the data as a 
linked object, then click on the object 
to select it 

Objects are identified by the 
selection handles around their 
perimeter. You will now close and 
open the document again… 

 Save and close the document, and 
then open the document again 

You will receive a message asking 
whether you want to update the 
linked data… 

 Click on [Yes] then save and close 
the document 

 

For Your Reference… 

To import linked Excel data: 

1. Copy the Excel data then switch to Word  

2. Click on the bottom half of Paste  and 

select Paste Special 

3. Click on Paste link and Microsoft Office 
Excel Worksheet Object under As 

4. Click on [OK]  

Handy to Know… 

 You can follow the same steps to import 
linked PowerPoint and Access data into a 
Word document. To import PowerPoint 
linked data, for example, such as a slide, 
click on Microsoft PowerPoint Slide Object 
in the Paste Special dialog box, then click 

on Paste link and click on [OK]. 

4 

6 

When you import linked data into a Word 
document, the linked data will update when 
changes are made to the source data or file. 
This is because you have only imported a link to 

the original data, not the data itself. When you open 
a document that contains linked data, you will be 
asked whether you want to update the linked data. 
Linked Excel data is imported as an object. 

7 
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IMPORTING AND EMBEDDING EXCEL DATA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Before starting this exercise 

you MUST open the file W883 
Importing_6.docx... 

 Ensure that W883 
Importing_4.xlsx is open in 
Excel 

 Click on cell A2, hold down 
 and click on cell G16, 

then press  +  to copy 

the data to the clipboard 

 Switch to Word, then click on 
the blank line below the 
paragraph The following 
table... 

 Click on the Home tab, then 
click on the bottom half of 

Paste  in the Clipboard 

group and select Paste 
Special to open the Paste 
Special dialog box 

 Ensure that Paste is selected, 
then click on Microsoft Office 
Excel Worksheet Object 
under As 

You are not linking the data, so 
there is no need to select 
Paste link... 

 Click on [OK] 

 Save the document 

 

For Your Reference… 

To import and embed Excel data: 

1. Copy the Excel data then switch to Word  

2. Click on the bottom half of Paste  and 

select Paste Special 

3. Click on Paste and Microsoft Office Excel 
Worksheet Object under As 

4. Click on [OK] 

Handy to Know… 

 You may notice that when you embed an 
object, the data in the object may appear 
fuzzy, or pixelated. This is common when 
importing embedded objects between 
Microsoft programs, so embedding data in 
this way may not be the best solution where 
clarity of data is essential.  

4 

6 

When you import and embed Excel data into a 
Word document (or data from any Microsoft 
program), the embedded data will not be updated 
when changes are made to the source data or 

file. When you embed an object in Word, it acts like 
any other object, such as pictures. In this way, you 
can work with the various Positioning and Text 
Wrapping tools, for example.    
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MODIFYING EMBEDDED EXCEL DATA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file W883 
Importing_7.docx... 

 Double-click on the embedded 
object to open it in an Excel 
window within the object frame 

Notice that the ribbon has 
changed to the Excel ribbon... 

 Click in cell B6, type 2 and 

press  

 Click in the document away 
from the worksheet to close 
the Excel window in the object 
frame 

Notice that all of the values 
from column C and onwards 
have been updated to reflect 
the change in the Annual 
growth. This change will not be 
made to the source file 
because this worksheet object 
is an embedded object (and 
not a linked object)… 

 Save and close the document 

 

For Your Reference… 

To modify embedded data: 

1. Double-click on the embedded object 

2. Make the desired changes 

3. Click outside the object to deselect it and 
return it to its static form  

4. Save the document 

Handy to Know… 

 The same principle applies when embedding 
data from other Microsoft programs, such as 
PowerPoint. When you embed a 
PowerPoint object and then modify it, the 
PowerPoint window and commands will open 
within the object frame so that you can edit 
the slide(s) as required. 

1 

3 

Once you have embedded data in a document, 
you can then modify that data in the destination 
document. Any changes made to the embedded 
data will not affect the source data. When you 

modify the embedded object, the object will open in 
its source program (such as Excel where you have 
embedded a worksheet) within the object frame, 
allowing you to make the necessary changes. 



Microsoft Word 2010 - Level 3 

© Watsonia Publishing Page 172 Importing 

NOTES: 
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